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This list of new file extensions, features, interface elements, and tools will give you the quick definitions you're 
likely to need as you begin getting up to speed with Office 2007 and fielding end-user support issues. 

 .docm: New XML-based file format used by Word 2007 for macro-enabled documents, so you can tell 
immediately that a file is capable of running embedded macros. 

 .docx: New XML-based default file format used by Word 2007 for documents, which uses compression 
technology to make file sizes smaller, structures files modularly so different components are kept 
separate for better recovery, and integrates easily with other programs that support XML standards. 

 .dotm: New XML-based file format used by Word 2007 for macro-enabled templates. 

 .dotx: New XML-based file format used by Word 2007 for document templates. 

 .potm: New XML-based file format used by PowerPoint 2007 for macro-enabled templates. 

 .potx: New XML-based file format used by PowerPoint 2007 for presentation templates. 

 .pptm: New XML-based file format used by PowerPoint 2007 for macro-enabled presentations, so you 
can tell immediately that a file is capable of running embedded macros. 

 .pptx: New XML-based default file format used by PowerPoint 2007 for presentations, which uses 
compression technology to make file sizes smaller, structures files modularly so different components are 
kept separate for better recovery, and integrates easily with other programs that support XML standards. 

 .thmx: New XML-based file format used for Office 2007 themes. 

 .xlsm: New XML-based file format used by Excel 2007 for macro-enabled workbooks, so you can tell 
immediately that a file is capable of running embedded macros. 

.xlsx: New XML-based default file format used by Excel 2007 for workbooks, which uses compression 
technology to make file sizes smaller, structures files modularly so different components are kept 
separate for better recovery, and integrates easily with other programs that support XML standards. 

 

.xltx: New XML-based file format used by Excel 2007 for workbook templates.  

Attachment previewer: A new feature in Outlook 2007 that allows you to preview e-mail attachments 
inside the reading pane with a single click. 

 

 -style Web site where entries are displayed in reverse 
 

 You 

Blog: Web log; a frequently updated journal
chronological order. Word 2007 supports publishing to a blog hosted by one of several blog service
providers, including Windows Live Spaces, SharePoint Services, WordPress, Blogger, and Typepad.
can publish a Word 2007 document as a blog post via the Microsoft Office button | Publish | Blog. 

 
 

Building blocks: Reusable bits of text, graphics, or other document content, or other components of 
documents, such as headers/footers, watermarks, and tables, which are stored in galleries and can be
used in any document or distributed with templates. 

 ok 2007 that lets you keep track of business data Business Contact Manager: A new feature in Outlo
stored as accounts, business contacts, opportunities, and business project records. 

 ndar in an e-mail Calendar snapshot: A new Outlook 2007feature that enables you to send your cale
message to be opened in Outlook or in a Web browser. 

 ves you a quick, visually distinctive way to Color categories: A new feature in Outlook 2007 that gi
customize e-mail, calendar, and task items and to search or sort by color. 

 cument that aren’t supported Compatibility Checker: A feature in Office 2007 that lists elements in a do
or may not behave the same way in previous versions of Office. These elements are shown before you 
save a document in a previous version file format. 
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 Compatibility Mode: A feature that allows you to create documents in Office 2007 that do not contain 
new or enhanced features unique to Office 2007, so others using previous versions of Office will have full 
editing capabilities. 

 Content controls: Individual controls that can be added and customized to be used in templates, forms, 
and documents, which are added to documents via the Developer tab on the Ribbon. 

 Contextual spelling: An option in the spell checker that detects and corrects the types of errors that 
previously got through spell checkers because the word was spelled correctly but was the incorrect word 
for the context (for example, misuse of the word “there” in place of “their”). 

 Contextual Tabs: The tabs that appear on the Ribbon according to the type of object you've entered or 
selected in a document.  

 Dialog box launchers: Small icons that appear in some groups on the Ribbon, which can be clicked to 
open a dialog box or task pane and provide more options related to the group. 

 Document Information Panel: A new feature in Office 2007 that allows you to easily view and edit 
document properties while working on the document. The document panel is displayed at the top of the 
document. 

 Document Inspector: A new feature in Office 2007 programs that helps you locate and delete hidden 
data and personal information in Office documents, spreadsheets, and presentations, such as comments 
and revision information, metadata, header and footer information, hidden text, and custom XML data. 

 Editing restrictions: A feature in Office 2007 that allows you to control what types of editing others can 
perform on the document (for example, you can allow only comments). 

 Electronic business cards: An Outlook 2007 feature that lets you share customized contact information 
with logos and photos that can be saved to the Contacts folder. 

 E-mail postmark: A new feature in Outlook 2007 that helps prevent spam by challenging the sender’s 
computer to perform a computation or puzzle to validate it. 

Enhanced ScreenTips: Sort of a mini-help system that appears when you hover the mouse over an 
element of the Ribbon, the new ScreenTips provide the feature name and a description, along with details 
about feature usage and links to related articles.  

 

Fluent user interface: The overall interface in Office 2007, which includes the Ribbon, formatting 
galleries, pop-up formatting menus for highlighted text, contextual tools that appear only when you need 
them, and so forth. 

 

Formatting galleries: Collections of preformatted content you can choose from when working on a 
document belonging to a particular template type. 

 

 u to restrict other users from changing Formatting restrictions:
the formatting or styles for a part of a document or the entire document, while still allowing them to 
change the content itself. 

 A feature in Office 2007 that allows yo

 : New name for what was previously called Reading Layout mode in Office Full screen reading view
2003.  

 Management: Document protection technology included in Microsoft Office 2007 

 can 
 

Information Rights 
that works with Microsoft’s Windows Rights Management Services (RMS). It lets you control what 
recipients of documents, workbooks, presentations, and e-mail messages can do with the files. You
restrict recipients from forwarding, copying, saving, or changing the content and set expiration dates after
which they can no longer view the content. You can create protected files in Office 2007 Professional 
Plus, Enterprise, and Ultimate editions. You can view protected files in all versions of Office 2007. 

  in Instant search: A new feature in Outlook 2007 that lets you organize and instantly find information
Outlook, regardless of what folder it’s in. 

 hic method for authenticating the creator or sender of a 
d or 

 

Invisible digital signature: A cryptograp
document or e-mail message and ensuring the integrity of the content (that it has not been change
tampered with after the signature was added); uses a digital certificate with a public/private key pair. An
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invisible digital signature does not show up in the content of the document but can be viewed by the 
recipient in the Office program. 

 entation of the previous ALT menu accelerator shortcuts (e.g., ALT+F, to KeyTips: An Office 2007 implem
open the File menu). By pressing ALT in Office 2007, users can display the KeyTips on the Ribbon 
elements, which indicate which key to press to access a particular feature. 

  two documents and display Legal blackline option: A feature in Word 2007 that allows you to compare
only what is different between them, accessed via the Review tab | Compare Group | Compare item on 
the Ribbon. 

 : A sneak peek at how a Gallery selection will affect your document. You can move the Live Preview
mouse over a Gallery option to "try it on" and see how it will look before committing to selecting the 
option. 

  Final: A new option in Office 2007 that allows you to mark a document as final to make it read-Mark As
only and prevent others from making changes to it. 

 rties of an Office document, such as word count, 
e 

Metadata: Data that describes other data; the prope
author, subject, date of creation, and so forth. Some metadata is automatically maintained by the Offic
programs, and you can add other metadata, such as comments, keywords, and categories, manually. 

Microsoft Office 2007 Compatibility Pack: Free program that can be downloaded and used to view an d 
edit files created in Office 2007 programs with Office 2000, XP, or 2003 (with appropriate service packs 
installed). 

 Office button: The button displaying the Office logo in the upper-left corner of Office 2007 
. 

Microsoft 
programs, which contains the main menus for the Office program, along with a list of recent documents

 
ery 

Microsoft Office Diagnostics: A series of diagnostic tests included in Office 2007 that can identify 
computer problems causing crashes. It replaces the Detect And Repair and Office Application Recov
features in Office 2003. 

 age of tools that appears when you select text in an Office 2007 document. 
g 

Mini Toolbar: A ghost im
When you move the mouse over the ghost toolbar, it becomes a functioning toolbar with text formattin
options. 

 e: An Outlook 2007 feature that lets you navigate multiple calendars stacked on top of one Overlay mod
another. 

 Document Format (PDF): A file format that preserves document formatting in a fixed layout Portable 
and ensures that when the document is viewed or printed, it will retain the exact original format. You can 
save documents in PDF format in Office programs after installing the Microsoft Save As PDF Or XPS 
add-in for 2007 Microsoft Office programs, which you can download here.  

  Office window to the right of Quick Access Toolbar: A small toolbar located by default at the top of the
the Microsoft Office button, which provides quick access to tools you need frequently (by default, Save, 
Undo, and Repeat Typing). It can be customized to add other tools to which you want quick access. 

Quick Style sets: A feature in Office 2007 that allows you to select from a gallery of styles to preview  
and apply a set of styles to a document. 

 7 
roup | Research selection on the Ribbon. 

Research options: Reference books and research Web sites that can be accessed through Office 200
w tab | Proofing gprograms via the Revie

Ribbon: The new tabbed interface that groups Office tools by tasks so that the ones that are used most 
frequently are easy to find. It replaces the traditional Office menus and toolbars. 

 

 RSS: Really Simple Syndication; a method of distributing standardized content that is updated frequently
through “feeds”. RSS is supported by Outlook 2007. 

 

 Signature line: An element that can be inserted into an Office document that can be clicked to add a 
visual representation of the signature (typed, handwritten via the ink feature on Tablet PC, or as a graphic 
of the signature). It simultaneously adds a digital signature to authenticate the sender’s identity. The 
document becomes read-only after being signed. 
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or follow-up; it gives you a consolidated view of 

To-Do Bar: A new feature in Outlook 2007 that integrates tasks, upcoming appointments, calendar 
information, and e-mail messages you’ve flagged f
priorities for the day. 

 ssed 
e button | <Program Name> Options. 

Trust Center: A centralized location for security and privacy settings in Office 2007 programs. Acce
via the Microsoft Offic

 Version Extraction Tool: A tool included in the Office Migration Planning Manager (OMPM) that allows 
you to save versions of documents created in previous versions of Office as multiple files. (Office 2007 
doesn’t support the versioning feature.) 

 p 
entiated from their counterparts in previous versions of Office by 

XML formats: New default file formats for Office 2007 programs that are based on the Extensible Marku
Language (XML) and are generally differ
an “x” appended to the end of the file extension (e.g., .docx, .xlsx, .pptx). 

XML Paper Specification (XPS): A file format that preserves document formatting in a fixed layout and 
ensures that when the document is viewed or printed, it will retain the exact original format; similar to 

 

PDF. You can save documents in XPS format in Office programs after installing the Microsoft Save AS 
PDF OR XPS add-in for 2007 Microsoft Office programs, which you can download here. 
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Additional resources 
• TechRepublic's Downloads RSS Feed  
• Sign up for TechRepublic's Downloads Weekly Update newsletter 
• Sign up for our Microsoft Office Suite newsletter 
• Check out all of TechRepublic's free newsletters 

 "A few things you'll miss when you upgrade to Office 2007" (TechRepublic download) 
 "Explore what is new and different in Microsoft Word 2007" (TechRepublic download) 
 "Master file and format management in Microsoft Office 2007" (TechRepublic download) 

Version history 
Version: 1.0 
Published: May 1, 2007 

Tell us what you think 

TechRepublic downloads are designed to help you get your job done as painlessly and effectively as possible. 
Because we're continually looking for ways to improve the usefulness of these tools, we need your feedback. 
Please take a minute to drop us a line and tell us how well this download worked for you and offer your 
suggestions for improvement. 

Thanks! 

—The TechRepublic Downloads Team 
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